
INTRODUCTION TO PROJECT MANAGEMENT - MS PROJECT  

 

1. Definitions of basic terms 

Project 

Today, many activities in society, organizations and enterprises are carried out in 
the form of time-limited projects. The implementation of projects leads to 
significant changes, which result in the creation of a new product, service, unique 
solution or streamlining and modernization of activities and services that are 
provided in a new quality. When defining the term project, we are based on several 
definitions:  

✓ A project is a temporary effort that aims to create a unique product, 
service, or achieve a certain outcome.  

✓ A project is an organized effort aimed at achieving a certain goal and can 
be understood as a work plan that has a result at the end.  

✓ A project is a unique process carried out to achieve a goal. In general, it 
consists of a set of coordinated and managed activities with specific 
start and end dates, while respecting defined requirements and 
constraints in terms of time, costs and resources.  

From a practical point of view, a project is a set of tasks that are carried out (and 
must be completed) according to a developed timetable to achieve a set goal. 
Tasks are performed by a group of people (project team) led by a project manager, 
who is a key person in the successful management of the project progress. The 
project manager supervises project planning, managing the schedule of project 
tasks, monitoring the fulfilment of tasks and deadlines, identifying problems and 
possible risks threatening the project, applying changes in the project and 
successful completion and evaluation of the project. From the point of view of 
project team management, the task of the project manager is to assemble it, 
assign tasks and responsibilities, coordinate work, ensure communication 
between team members and inform the team about the progress and results of the 
project. 

 

Project characteristics 

Based on definitions, it is possible to define the characteristics of a project that 
distinguish it from commonly performed processes or activities as follows: 

✓ The project is unique and unrepeatable - it creates a unique product or 
service. 

✓ The project has a clearly defined goal. 
✓ The project is temporary - it has a defined beginning and end, after reaching 

the goal, it ends. 



✓ The project has a developed plan - a comprehensive document that 
describes the goals, schedule, budget of the project. 

✓ The project is developed gradually (from the general objective to its more 
detailed formulation). 

✓ The project has limitations - it must be completed within the specified time, 
achieve a defined set of tasks and goals, and must adhere to the set budget. 

✓ Labour, material and financial resources are consumed during the 
implementation. 

✓ The project is implemented by the project team and managed by the project 
manager.  

✓ The project has a client who determines the direction of the solution and 
releases financial resources. 

✓ The project is characterized by complexity – various methods and means 
are used during its solution.  

✓ The project has a high level of uncertainty and risk due to external factors. 
 

Examples of projects by industry: 

✓ Information and communication technologies (building a network 
infrastructure of the company, introducing a new ERP system of the 
company, development of a mobile application, development of a website) 

✓ Construction (construction of road infrastructure, construction of an 
apartment complex, bridge, shopping centre) 

✓ Production (modernization or introduction of a new production line) 
✓ Marketing (launching a new product/service, launching an advertising 

campaign) 
✓ Organization of a unique event (conference, music festival, international 

exhibition) 
✓ Science and research (development of new medicines) 

 

Project triangle 

Each project is limited by its time, cost and scope. A project triangle is used to 
graphically represent the interdependencies between: 

✓ costs (total price of the project),  
✓ time (total project duration). 
✓ scope (overall complexity and work of the project)  

The quality indicator (project outputs) is added to the triangle. 

 

 

 

 



 

 

 

 

 

 

 

Figure 1  Project triangle - optimally managed project 

 

The aim of the project implementation is to: 

✓ achieve the desired parameters of the product, service or result, 
✓ meet them within the set deadline or earlier, 
✓ within the set budget. 

Neither side of a triangle can be changed without affecting at least one of the other 
two sides of the triangle, such as: 

✓ Reducing costs can increase the duration of the project and reduce its 
scope. 

✓ Reducing the time (duration) can lead to increased costs and a 
reduction in the scope of the project. 

✓ Increasing the scope can prolong the project in time and increase costs. 
In practice, project management brings various complications and the "balance" 
between constraints is violated. Most often, there is a delay in the schedule (time), 
cost (budget) overruns, when the effort to meet the time or budget of the project 
leads to a deterioration in its quality. According to the published results of the 
survey (PM360, 2023), up to 70% of projects are unsuccessful, or the project solver 
does not deliver what was promised to the customer. The most common reasons 
for project failure are budget overruns (55%), mismatch between business and 
project goals (44%), lack of support from project sponsors (41%), unclear project 
goals (37%). 

 

When is a completed project evaluated as successful? 

From the point of view of the project triangle, a project is successful if it has 
achieved the planned goals in the required quality, within the specified time, while 
adhering to the planned costs, has not caused negative impacts and the interested 
party (client/customer) is satisfied with the result. 

 

 

Time + Cost + Scope = Quality 

 



Project management 

Project management is a way of organizing work to manage unique tasks and 
activities that are different from routine, day-to-day processes. What 
distinguishes the project from the process management and routine management 
of the organization's activities is its uniqueness and final outputs. The founder of 
project management is Henry L. Gantt, who, together with F. Taylor, began to apply 
the scientific principles of management in American steel mills (1887-1893).  For 
the analysis of work procedures in production, he introduced the so-called A Gantt 
chart in the form of a graphically represented sequence of project activities. 
Project Management Definitions:  
✓ Project management is a special type of management focused on 

planning, implementing, tracking and evaluating project results. 
✓ Project management is the planning, organization, and management of 

project activities and resources, while respecting time, resource, and cost 
constraints. 

✓ Project management is the application of knowledge, knowledge and 
skills, tools and techniques to project activities to meet the requirements 
of the project. It involves planning, organizing, monitoring and reporting on 
all aspects of the project and motivating all stakeholders to achieve the 
project objectives.  

✓ Project management is the sum of activities consisting in planning, 
organizing, managing and controlling the resources of a company with a 
relatively short-term goal that has been set for the implementation of 
specific goals and objectives.  

The application of project management in project implementation should answer 
the questions: 

✓ What tasks must be performed and in what order?  
✓ In what time sequence should the tasks be carried out and what is the 

deadline?  
✓ Who will complete these tasks?  
✓ How much will it cost?  
✓ What if some tasks are not completed as planned?  
✓ How to communicate the details of the project after its completion? 

The implementation of a project in the sense of project management theory is 
preceded by its preparation, which means defining the goal (purpose) of the 
project, developing a time schedule of tasks and allocating fulfilment resources. 
During the implementation of the project, individual tasks of the schedule are 
performed by resources - the project is "shifted" to its end. At this stage, the project 
manager continuously checks and monitors the implementation of the project 
plan. After completing all tasks, the project is formally completed, the final 

https://sk.wikipedia.org/w/index.php?title=Frederick_W._Taylor&action=edit&redlink=1
https://sk.wikipedia.org/w/index.php?title=Mana%C5%BEmentu&action=edit&redlink=1


product is handed over to the client and the final project documentation is 
processed. 

Project lifecycle 

Every project has a defined beginning and end. The project is divided into phases 
in terms of time and the nature of the activities carried out. The sequence of 
individual phases of a project forms its life cycle. According to PMI (2008), the 
project life cycle is a set of generally successive phases through which a project 
passes from its inception to its completion, the names and number of which are 
determined by the needs of the organization implementing the project.  

In general, the life cycle of a project consists of phases: 

1. Initiation (initiation) 
2. Project preparation and planning 
3. Implementation  
4. Project management (control and monitoring) 
5. Termination 

The phases are arranged in a logical sequence - the output (termination) of one 
phase is usually the input for the next phase (Figure 2). The exception is the 
planning and management phases, as they are present in all phases of the project 
lifecycle. 

Figure 2  Project lifecycle phases I 

 

Project initiation - is the phase of starting a project, defining the project (purpose, 
goals, scope, stakeholders). It is a formulation of an idea of what is to be achieved 
by the implementation of the project. For this purpose, the Feasibility Study and 
the Project Plan documents have been prepared. In practice, the Feasibility Study 
document is usually a condition for project approval, demonstrating whether the 
project is economically and financially feasible and sustainable. A project plan is 



a comprehensive document that describes the objectives of the project, its 
activities, sources of funding, timeline, expected results and possible risks. 

Project preparation and planning - is the most important and demanding phase 
of any project. In this phase, a project team is "assembled", which, together with 
the project manager, develops a comprehensive and detailed project plan. The 
plan specifies and describes in detail the project activities, task schedule, time 
schedule, resource plan, project budget, risk plan and project outputs 
(quantitative and qualitative parameters). 

Project implementation - at this stage, the project plan is put into practice: 
individual tasks and activities are implemented in real time, resources are 
consumed, and funds are drawn according to the budget. The phase involves 
allocating, coordinating and managing human, material and budgetary resources.  

This includes regular meetings of the project team to monitor the progress of the 
project, and if necessary, adjustments to the project baseline. The result of the 
phase is the creation of material outputs of the project and their handover to the 
client.  

Project management - takes place throughout the project life cycle and is carried 
out by the project manager in accordance with the project plan and risk 
management plan. The essence is the control and monitoring of project activities, 
monitoring the progress of project implementation, changes to the original plan 
(as needed).  

Completion of the project - is the final stage of implementation. The project is 
factually and formally completed, its progress, benefits, fulfilment of goals are 
evaluated, and the final documentation is compiled. At the same time, the 
problems that arose during the implementation of the project are summarized to 
prevent these problems in similar projects solved in the future. 

 

2. Microsoft Project Software Tool  

Microsoft Project is a specialized project management software tool, covering all 
phases of the project lifecycle from planning to project completion and evaluation. 
The program is available in several editions: 
✓ Local solutions: standalone desktop application (MS Project Standard, MS 

Project Professional) or server (Project Server) 
✓ Cloud solutions in Microsoft 365: Project Online Professional and Project 

Online Premium, Project Web App (browser-based interface). 

In the text, we present practical samples/outputs of the desktop version of MS 
Project Professional 2019.  

 



How to process a project through MS Project? 

Based on the theory of project management, the main point of practical project 
implementation is its detailed development into a plan. It is a relatively demanding 
process that "copies" the project life cycle - from defining tasks, allocating 
fulfilment resources, continuous control and monitoring of task fulfilment, to 
project completion and evaluation. The MS Project program can be used 
throughout the process. Its use in solving each specific project is only a supporting 
tool for the project manager, the success of the project is based on the knowledge 
and skills of the project manager in project management and the project team. MS 
Project can be used for the following project activities: 

✓ Create a structured project plan. 
✓ Define in detail the tasks of the project and the time schedule for their 

fulfilment. 
✓ Define the resources that will be used to complete tasks. 
✓ Define costs at the level of the task, stage, the entire project. 
✓ Monitor the progress of the project plan. 
✓ Apply different views and reports to your project. 
✓ Process output reports for project evaluation.  

 

MS Project User Interface 

After starting, the program asks the user to select a working file: create a new, 
empty project or open an already processed project. The user also has a choice of 
project templates (i.e. a pre-prepared project with all characteristics: duration, 
tasks, resources and their assignments, Gantt chart). The program's working 
window is structured as follows: 

1. Main Command Menu   
2. Ribbon: graphic-command menu for individual command tabs 
3. Tools: context menu for the View panel 
4. Document part of the project: tabular part and graphic part 

 
The tabular part of the project is used to insert project tasks into rows (task name), 
columns have names and define other characteristics of the task (e.g. duration, 
start/end date of the task, predecessors, etc.). Rows and columns can be 
added/removed as needed. On the right side of the view is a Gantt chart in which 
the sequence of tasks is graphically displayed - the tasks are displayed in the form 
of "tabs" - Figure 3. 
 



 
Figure 3  Program Work Window 

 
Main Menu 

The main menu contains all the commands needed when working with a project 
file. Individual tabs logically group commands by main areas: 
✓ The File tab contains commands for working with the project file (create a 

new one, open/save/print an existing project) or change program settings. 
The Project Information menu allows you to display the Advanced 
Properties of the project file (descriptive information of the project: name, 
subject, author, keywords) or Project Statistics (specific information 
about the project being processed - Figure 4. 

 
 
 
 
 
 
 
 
 
 
 

 
Figure 4  File Menu - Project Information 

✓ The Task tab contains commands for working with tasks in the project - it 
allows you to insert different types of tasks, format them, set the 
percentage of task completion, view the details of each task. It also 

The table section shows the individual 
tasks and their characteristics 
 

Graphical part - Gantt chart 
graphically shows the sequence of 
tasks 
 

The sidebar is used to select 
different views of the project 

  



includes the ability to set a task scheduling mode (manual, automatic) and 
the ability to check project tasks (check for dates and time discrepancies). 

 
Figure 5  Tab Task 

✓ The Resource tab contains commands for working with resources that 
perform tasks. You can use commands to assign resources to tasks, view 
their properties, or level off overallocated project resources that are 
overallocated due to their over assignment to tasks (the resource's 
available working capacity is less than the total time required to complete 
those tasks). MS Project works with three types of resources; their detailed 
description is in next chapter. 

 
 

Figure 6 Tab Resource 
 

✓ The Report tab contains commands for creating various graphic/visual 
reports (outputs) of the project. It also allows you to compare two versions 
of a project. In practice, reports are used to monitor the progress of the 
project (evaluation of some statistics), but they are mostly used in the final 
phase - completion and evaluation of the project. 

 
 

 

Figure 7  Tab Report 
 

✓ The Project tab contains commands that apply to the project (set project 
information, project calendar, track project progress, and check project 
status). 

Figure 8  Tab Project 
 



✓ The View tab offers various views of tasks, resources, allows filtering/sorting 
of tasks or resources, setting a time scale for a Gantt chart, or displaying a 
project timeline. 

Figure 9  Tab View 
 

✓ The Tab - Gantt Chart Format tab is designed to format the Gantt chart, it 
offers predefined color styles. It allows you to view critical tasks, task slack. 
In addition, it allows you to view the project outline, task summaries, and 
outline numbers, which displays a structured project schedule divided into 
individual phases with subtasks. 

 
Figure 10  Tab Gantt Chart Format 

 
 
Processing a project in MS Project  

A project is a work schedule that is preceded by the initial preparation of the 
project: defining a list of tasks, defining task fulfilment sources, and defining 
important deadlines. The preparation of the project in the program consists of the 
following activities: 

1. Defining the tasks of the project and the time schedule for their fulfilment. 
2. Define project resources and assign them to tasks. 
3. Display of costs at the level of the task, stage, entire project. 
4. Creating a structured project plan - dividing the project into summaries 

(stages), setting milestones. 
 
 
After creating a new project file, the program asks for the Project Information 
setting (Figure 11), where you need to enter the start1 or end date  of the project 
and other project characteristics. At the same time, you need to set up all 
exceptions for non-working time (for example, holidays during the year) in the 
Project Calendar. 

 
1 For a project planned from the start date, it is crucial when the project ends. When scheduling from an 
end date, a fixed end date is determined in advance (e.g., a product launch date announced).  



 
Figure 11  Setting up a project 

 

The next step is to insert the project tasks into the tabular portion of the Gantt 
Chart view. Each project consists of its division into sub-activities - tasks, so it is 
advisable to have a detailed list of tasks that form the "skeleton" of the project plan 
prepared in advance. In a program for working with tasks, the Task tab is used.  

 
Figure 12  Project example 

 

Figure 12 shows an example of a processed project. In the table section, tasks are 
displayed as a numbered list. Each task has defined characteristics in columns: 
name, duration, start and finish dates, dependency on other tasks (so-called 
predecessors) and allocated resources. In the graphic part, the tasks are shown in 
the form of coloured strips, the length of the strip expresses the duration of the 
task.  The progress of all tasks is displayed as their sequential sequence (the so-
called waterfall model of the project), expressing the sequence of task 
completion. To create a structured form of the project, it is necessary to group the 
related tasks into summaries, several summaries form the overall outline of the 
project. 

A separate view of the summaries (and their subtasks) is the timeline, which 
shows the sequence of project stages in colored blocks.  
Different types of tasks can be inserted into the project: 



✓ Common task - has a specified start and end date and has resources allocated 
for their fulfilment. 

✓ Milestone - is a task with zero duration, indicates an important event in the 
project (for example, the completion of a project stage), has no resources 
assigned to it, and is usually the last task of that stage. A milestone identifies a 
critical point in the project plan (as a "transition" point to a new stage of the 
project). In the Gantt chart, it is identified by the icon .    

✓ Recurring task - has a defined time interval of regular repetition during the 
project (e.g. control meetings of the project team), the indicator of a repeated 
task is the .  

Summary - represents the stage of the project, it is made up of a list of subtasks. It 
is highlighted in bold in the text and in the Gantt chart by a continuous line above 
the subtasks. 

After you create a project schedule, you need to assign resources to each task to 
perform the tasks. Resources are continuously consumed during the completion 
of project tasks. The following types of resources can be assigned to tasks in a 
project: 

✓ Work resources (people or an inanimate work resource, e.g. a special 
device). The specificity of work resources is their limited availability, they 
have their own defined calendar, which determines their working and non-
working hours. Poor planning of assigning a work resource to multiple tasks 
at the same time can lead to resource overload, which means that More 
work is required of the resource than it is able to do in a given time. The 
program indicates that the resource is overloaded with an icon in the tabular 
part of the Gantt chart. Resource overload is a risk that, in practice, can lead 
to missed deadlines and disrupt project schedules. There are several 
techniques for eliminating the overload of working resources, in the 
program there is a separate menu for balancing resources.     

✓ Material resources are consumed during the implementation of the 
project. These resources are not limited in capacity and in case of 
exhaustion, they can be replenished in a short time in the required or 
unlimited amount (e.g. sand). They are defined in units of measurement 
(liter, meter, piece). They do not have a defined calendar and availability. 

✓ Cost resources are expressed as fixed costs when assigned to a specific 
task (e.g., airfare, space rental, training cost). They do not have a defined 
calendar and availability.  



When you insert resources into a project, you must define a cost for each 
resource in the Resource Sheet (Figure 13) - cost per unit of work of a work 
resource, price per unit of material consumed, or fixed cost. 

Figure 13       Resources and cost statement 

When you assign resources to tasks, the program automatically recalculates all 
costs, and the total project budget and sub-budgets of each project stage are 
displayed. The Project Statistics view shows other important information about 
the project: total duration (in days), total work (in hours), and total cost (see Figure 
13).    

After the project plan is processed in the program, the project implementation 
phase follows, the individual tasks begin to be fulfilled according to the schedule. 
At this stage, it is important to continuously check the implementation of the 
project plan by the project manager and the responsible project team members. 
The control allows you to react to unexpected events that occur during the 
implementation of the project (e.g. employee outage, non-delivery of materials, 
bad weather, etc.) and to modify the original project plan (e.g. replenishment of a 
worker, time shift/shortening of the task duration). With the help of the program, 
the project manager can: 
✓ Track the progress of the project plan and update it. 
✓ Apply different views and reports to your project. 
✓ Process output reports for project evaluation. 

To track the progress of the project in MS Project, it is necessary to save the so-
called the original plan, which is a copy of the plan that was originally created. 
The baseline contains the initial setting of all project values (time units, resource 
allocations, budget) and can be understood as a "model solution" of the 
developed project schedule. In the current project, the data of individual tasks is 
continuously updated according to their actual progress - real task durations, 
actual work performed, real costs are entered. The project manager can monitor 
and analyze how the actual implementation of the plan differs from the original 
plan. As needed, it can change the actual project schedule, deploy additional 
resources to tasks, or reschedule tasks. 

To display the tracking of the actual progress of the project, it is possible to use the 
Gantt chart view for tracking (Figure 14), where the graphic part shows the 
progress of the project (percentage of task completion) as well as the difference 
between the actual (blue bar) and the original (gray bar) project plan. the critical 



path of the project (red bar), i.e. the sequence of tasks that have a direct impact 
on the project's finish date (for example, tasks that cannot be postponed, 
otherwise the entire project would be delayed). 

A suitable view for monitoring the actual progress of the project is also  the Project 
Statistics (Figure 5 – previous chapter), where the difference between the original 
plan and the current plan for Duration, Work and Project Costs is summarized. 
Based on them, the project manager can determine whether the project "sticks" to 
the originally planned values and what is the percentage of project completion in 
relation to the total time and work performed.  

 

Figure 14       Tracking Gantt Chart 

 

Project completion is the last phase of the project: all project tasks are completed, 
the achieved result of the project is formally accepted and accepted by the project 
client, the project team is dissolved. At this stage, the project is evaluated, and the 
final project documentation is processed. When processing the final project 
report, MS Project is used mainly for the processing of output reports (Figure 15). 
The reports provide a simple form of analysis and evaluation of the project, they 
are intended exclusively for printing. The user can use the predefined templates 
and modify them according to their requirements. The visual appearance of 
reports is in the form of tables, graphs, comparisons. 



 
Figure 15       Output report – Cost overview 

 


